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                      Word програмаар баримт үүсгэх, баримттай ажиллах  

Загварт суурилсан шинэ баримт үүсгэх: Хэрэглэгч баримтыг бичихээс гадна хэрэглэгч 

үүсгэж буй баримтандаа тохирсон бэлэн загварыг ашиглаж болно. Шинээр үүсгэх баримт 

нь албан ёсны загвартай болохын зэрэгцээ баримтыг форматлах ажлыг хөнгөвчлөх ач 

холбогдолтой. Баримтын цонхонд текст, хүснэгт, схем, график гэх мэт өгөгдлүүдийг 

оруулна. Баримтын цонхонд курсор нь босоо анивчсан зураас хэлбэртэй байдаг. Оруулсан 

өгөгдөл курсорын байрлалд тавигддаг. Текстэн мэдээлэл боловсруулахад хамгийн чухал 

зүйл бол өгөгдлийг өөрчлөх, засварлахад оршдог.  Word програм нь баримтын текстийг 

дахин шинээр бичилгүйгээр хялбархан засварлах боломжтой. Мөн бүрэн бус баримтаа 

хадгалаад дараа нь уг баримтаа нээж үргэлжлүүлэн ажиллаж болно. 

Энэхүү сэдвээр хэсэгт баримтын цонхонд хэрхэн шинээр өгөгдөл оруулах, устгах, өөрчлөх, 

баримтан дунд текстийг оруулах, мөн боловсруулсан баримтаа хэвлэх, хадгалах, хаах, 

програмаас гарах гэх зэргийн талаар судална. 

Програмын цонхны эргэн тойронд хулганыг шилжүүлэх үед хулганы заагуурын хэлбэр 

өөрчлөгддөг. Тухайлбал; цэсийн мөрөн дээр хулганы заагч баруун тийш харсан сум 

хэлбэртэй, баримтын текст бичигдэхгүй зүүн хэсэгт зүүн тийш харсан сум хэлбэртэй болох 

ба тэр бүрдээ тодорхой үүргийг агуулж байдаг.  Баримтын цонхонд хулганы заагуур нь I-

beam дүрсээр өөрчлөгдөж хулганы товчин дээр нэг дарах замаар текст бичих боломжийг 

олгоно. 

Word програмтай хамт суугдсан жишээ загваруудаас сонгохдоо: 

1. File/ New командыг сонгоно. 

2. Available Templates дэх Simple template дээр дарна.  

3. Өөрийн хүссэн загвараа сонгон Create товч дээр товшино. (Зураг 1) 

 



 

  Зураг 1  Баримтанд суурилсан шинэ загвар үүсгэх цонх 

Түүнчлэн, office.com хаягнаас ажлын талбарын загварыг татаж авч болно. (Зураг 2) 

1. File/ New командыг сонгоно. 

2. office.com templates дэх загвараас өөрийн хэрэгцээ шаардлагатай нийцүүлэн загвараа 

сонгоно. 

- File цэсний New командыг сонгоод, General хэсгийн Blank Page-ийг сонгох 

- Сtrl+N товчийг дарах 

аргуудын алиныг ч хэрэглэж болно. Хамгийн хялбар арга нь хэрэгслийг ашиглах арга юм. 

Энэ шинэ баримт нь Normal.dot стандарт загвар дээр үндэслэгдэнэ. 

File цэснээс New командыг сонгоход шинээр үүсэх баримтын загварыг асууна. 

1. File цэсний New команд сонгоно. 

2. New гэсэн шинэ цонх нээгдэнэ. Энэ цонхноос өөрийн хэрэглэх загварыг сонгоно. 



3. Загвараа сонгон Download товчлуур дээр дарна. Энэ тохиолдолд таны компьютер 

сүлжээнд холбогдсон байх шаардлагатай. 

Зураг 2  Оffice.com ашиглан бэлэн загвар татах 

Оффис товчийг сонгож нээгдэх цонхонд байрлах Word Option командыг сонгоно. 

Нээгдэх цонхны Advanced жагсаалтын Display бүлгээс  (дэлгэцийн энгийн горимд хэвтээ 

удирдах шугамыг харуулах) хяналтыг товчийг сонгоно. 

Удирдах шугам нь стандарт үедээ inch хэмжигдэхүүнээр илэрхийлэгддэг. Үүнийг бидний 

хэрэглэж заншсан нэгж болох сантиметрт шилжүүлж болно. Ингэхдээ дээрхийн адил  

Advanced жагсаалтын Display бүлгээс   хэмжих нэгжийг үзүүлэх  гэсэн талбараас 

сонголтыг хийнэ.  Tools цэсний Options командаар нээгдэх харилцах цонхны General 

хуудасны Measurement units талбараас Centimeters (inches, points, picas)-ийг сонгоно. 

                    Баримтыг хамгаалах, хамгаалалтыг авах  

Гадны хэрэглэгч баримтыг нээх, засварлахаас хамгаалахын тулд нууц үгийг ашиглана. 

Ингэснээр баримтыг нээх, эсвэл засварлах эрхийг хязгаарлаж буй ач холбогдолтой. 

Баримтанд засвар өөрчлөлт хийхгүйгээр зөвхөн уншиж танилцах боломжтой (Зураг 3) 

1. Хамгаалалт хийх баримт идэвхтэй байна. 

2. File/ Info командыг сонгоно. 



3. Нээгдэх information <баримтын нэр> цонхны Permissions дэх Protect Document 

товчлуур  дээр дарна.  

4. Нээгдэх цэснээс  Restrict Editing командыг сонго. 

 

   

 

 

 

 

 

 

 

 

 

 

                  

Зураг 3   Баримтанд нууцлал хамгаалалт хийх 

5. Ажлын талбарын баруун талд Restrict Formatting and Editing зорилтод цонх нээгдэх 

ба Allow only this type of editing in the document товчлуурыг идэвхжүүлнэ. 

6. Харгалзах талбарын жагсаалтаас No changes (Read only) сонголт хийгдсэн байх ёстой. 

7. Yes, Start Enforcing Protection  товчлуур дээр дарна. 

8. Нээгдэх Start Enforcing Protection харилцах цонхны Enter new password (optional) 

талбарт засвар  өөрчлөлтийг хийх эрх олгох нууц үгийг оруулна. Энэ нууц үгээ Reenter 

password to confirm талбарт давтан баталгаажуулан орно. 

9. OK товчлуур дээр дарна.  

Баримтын хамгаалалтыг чөлөөлөх : Баримтын хамгаалалтыг чөлөөлж, засвар хийхэд 

ажлын баруун талд  Restrict Formatting and Editing цонхны Stop Protection товчлуур дээр 

дарна. Unprotect харилцах цонх нээгдэх ба нууц үг оруулаагүй баримт бол хамгаалалт шууд 

чөлөөлөгдөнө. Нууц үгээр нээгдэх баримт бол Password талбарт нууц үгийг оруулж Oк 

товчлуур дээр дарна. Хэрэв энэ цонх нээлттэй биш тохиолдолд дараах аргаар нээнэ.(Зураг 

4) Үүнд:  



 File/ Info командыг сонгоно. 

 Нээгдэх information <баримтын нэр> цонхны Permissions дэх Protect Document 

товчлуур дээр дарна. 

 Нээгдэх цэснээс  Restrict Editing командыг сонгоно. 

Дээд талд орших хэвтээ удирдах шугам нь хулганы тусламжтайгаар параграфын догол мөр, 

таб зогсолт, цаасны зүүн, баруун талаас үлдээх зай, баганы өргөний хэмжээ зэргийг 

тохируулах боломжийг олгоно. Харин босоо удирдах шугам нь цаасны дээд, доод ирмэгээс 

үлдээх зайг тогтоох, хүснэгтийн мөрийн өндрийг өөрчлөх боломжийг олгоно. Удирдах 

шугамыг дэлгэцэнд гаргах эсэхийг тохируулахдаа босоо гүйлгэх зурвасын дээр орших View 

Ruler  командыг сонгох эсвэл View командын туузны Show/Hide бүлгийн Ruler хяналтын 

товчийг сонгоно. Хэрэв босоо удирдах шугам дэлгэцэнд харагдахгүй байвал дараах 

үйлдлийг гүйцэтгэнэ.   

 

Зураг 4 Баримтын хамгаалалтыг чөлөөлөх 

Баримтыг нээхэд нууц үг шаардахаар тохируулах 

1. Хамгаалалт хийх баримт идэвхтэй байна. 

2. File/ Info командыг сонгоно. 

3. Нээгдэх information <баримтын нэр> цонхны Permissions дэх Protect Document 

товчлуур дээр дарна.  



4. Нээгдэх цэснээс  Encrypt with Password командыг сонгоно. 

5. Нээгдэх Encrypt with Password харилцах цонхны талбарт нууц үгийг оруулаад Ok 

товчлуур дээр дарна. 

6. Нээгдэх Confirm password харилцах цонхны талбарт нууц үгийг давтан оруулаад Oк 

товчлуур дээр дарна. 

Ишлэлтэй ажиллах 

Ямар нэг баримт бичиг боловсруулж байх явцад тодруулан тодотгож харуулах шаардлага 

гардаг. Ийм тохиолдолд ишлэл буюу зүүлт хэрэглэнэ. Баримтын үндсэн текстийн хэсэгт 

тодруулга буюу тайлбарыг хийж, хэвлэгдэх хуудас эсвэл баримтын төгсгөлд оруулахыг 

ишлэл хийх (Footnote) гэнэ. (Зураг 5) 

 

                           

 

 

 

 

 

                          Зураг 5 Баримтанд ишлэл зүүлт тавих 

 

Баримтанд ишлэл зүүлт хийхэд:  

1. Ишлэл хийх үгийг төгсгөлд курсорыг байрлуулна.   

2. References товчлуурыг сонгоно.  

3. Footnotes цэсийн Insert Endnote товчлуур дээр дарна.  

4. Endnote  хэсэгт ишлэл зүүлтийн мэдээллийг оруулна. 

Текст хайх ба солих  

Хэрэв баримтаас үг хайж олох шаардлагатай бол Home цэсний Find командыг ашиглана 

(Зураг 6). Энэ командыг их хэмжээний баримттай ажиллах үед ашиглах нь тохиромжтой. 



Зураг 7-д үзүүлсэн баримтаас үг хайж олсны дараа Replace командаар хайж олсон үгээ шинэ 

үгээр сольж болно.  

 

Зураг 6 Баримтаас үг хайлт хийх ба солих командын хэрэгслэл 

 

Зураг 7 Баримтаас үг хайлт хийх ба солих командын цонх 

                         Хуудасны толгой ба хөлийн хэсгийн мэдээлэл   

Мэдээлэл болон хэлбэр хэмжээ хуудаснаас  үл хамааран хуудас бүрд давтагдах мэдээллийг 

хуудасны  толгой ба хөл хэсгийн мэдээлэл дүрслэх (Header and Footer) гэнэ. (Зураг 8)  

  

 

Зураг 8. Хуудасны толгойн ба хөлийн хэсгийн мэдээллийг оруулах 

Толгой ба хөл хэсгийн мэдээллийг эхний хуудсанд харуулахгүй байх мөн тэгш ба сондгой 

хуудаснуудын  толгой ба хөл хэсгийн мэдээлэл ялгаатай байх тохиолдолд дараах үйлдлийг 

гүйцэтгэнэ.  

1. Page Layout цэсний Page setup бүлгийн харилцах цонхыг нээнэ. 

2. Нээгдэх харилцах цонхны Layout хавтсан дахь дараах сонголтоос өөрийн хэрэгцээнд 

тохируулан сонгоно. 



Хуудсаны захаас  Header and Footer хүртлэх зайг тохируулна. Page Layout цэсний Page 

setup бүлгийн Layout хавтсан дахь дараах сонголтоос өөрийн хэрэгцээнд тохируулан 

сонгоно. Түүнчлэн, томоохон баримттай ажиллаж байхад баримтыг дотор нь бүлгүүдэд 

хувааж, бүлэг бүр нь өөр мэдээллийг хуудасны Header ба Footer хэсэгт оруулах шаардлага 

гардаг.  

1. Аль нэг бүлэгт хуудасны Header ба Footer хэсгийн мэдээллийг оруулна.  

2. Өмнөх бүлэгт шилжих бол Previous Section, дараагийн бүлэгт шилжих бол Next Section 

командыг сонгоно. Идэвхижсэн бүлгийн мэдээлэл нь өмнөх мэдээлэлтэйгээ адилхан 

байх бол Link to previous командыг сонгож Yes товчлуурыг сонгоно.  

                                         Үүсгэсэн баримттай ажиллах  

 Үүсгэсэн баримтанд толгой үсэг хийх : Толгой үсэг хийх үсгийг тэмдэглэнэ.  

1. Insert->Text->Drop Cap командыг сонгоно (Зураг 9) 

2. Эсвэл Drop cap options командыг сонгож, тохиргоо хэлбэрийг сонгоно.  

3. Position бүлгээс хэлбэрийг сонгоно. Options бүлгээс толгой үсгийн фонд, толгой үсгийн 

ард байрлах мөрийн тоо, текстээс толгой үсэг хүртэлх зайг тодорхойлоод Oк товчлуур 

дарна.   

 

Зураг  9  Толгой том үсэг оруулах 

 Текстийг багана хэлбэрээр дүрслэх:  Багана хэлбэрт оруулах текстэн баримтын 

хэсгийг идэвхжүүлнэ. Харин оруулах текстийг багана хэлбэрээр дүрслэх бол текст 



оруулах газраа курсорыг байрлуулна. Page layout->Page Setup бүлгийн Columns 

командыг дарж, өөрийн хийх баганын тоог сонгоно.  

 Форматын загвар: Томоохон баримттай  ажиллах явцдаа өөрийн цаг завыг хэмнэх, 

баримтаа илүү боловсронгуй бусдад ойлгомжтой, бүтэц нь тодорхой байлгах үүднээс 

илүү олон боломжуудыг ашиглах  шаардлага  гардаг. Стандарт загварт өөрчлөлт 

оруулах. (Зураг 10) 

- Home / Style бүлгээс аль нэг загварыг сонгоно. 

- Mouse-ийг хоёр удаа дарахад гарч ирэх харилцах цэснээс Modify командыг сонгоно. 

- Гарч ирэх харилцах цонхонд форматын загвараа тохируулна.  

Зураг 10 Баримтын загварт өөрчлөлт оруулах 

 Гарчигийн товъёог хийх : Товъёог үүсгэх байрлалд курсорыг шилжүүлнэ. Үүний 

тулд сэдвийн гарчигт  Home / Style бүлгээс формат тохируулсан байна (Зураг 11) 

1. Reference->Table of Contents командын хэрэгсэл дээр дарна.   

2. Гарч ирэх харилцах цэснээс Automatic table-г сонгоно. 

Товъёог үүсгэсний дараа хуудасны дугаар, гарчиг өөрчлөгдсөн тохиолдолд шинэчлэх 

шаардлага гарна.  



 Хуудсанд хавчуурга хийх : Баримтыг эргэж унших, шалгах газраа хавчуурга хийх 

боломжтой. Үүний тулд эхлээд хавчуурга хийх текстийг тэмдэглэх эсвэл курсорыг 

байрлуулна: 

1. Insert->Links->Bookmark командыг сонгоно. 

2. Нээгдэх Bookmark харилцах цонхны Name талбарт хавчуургын нэрийг оруулна. 

Хавчуурганд хандахдаа: 

1. Insert->Links->bookmark командыг сонгоно. 

2. Нээгдэх Bookmark харилцах цонхны Name эсвэл Location ангиллын аль нэгийг, 

сонгож хавчуургуудыг нэр ба байршлаар нь эрэмбэлнэ. 

3. Үндсэн талбараас хандах хавчуургын нэрийг идэвхжүүлнэ. 

4. Go To товчлуур дээр дарна. 

 Бүдүүвчийг байгуулах : Мэдээллийг хэрэглэгчдэд ойлгомжтой байлгах үүднээс 

бүдүүвчлэн хийх нь илүү тохиромжтой байдаг. Эхлээд курсорыг байрлуулна:  

1. Insert->Illustrations->Smart-Art командыг сонгоно.  

2. Нээгдэх Choose Smart-Art Graphic харилцах цонхны жагсаалтыг бүдүүвчийн төрлийг 

сонгоно.   

3. Харилцах цонхны баруун хэсэгт сонгогдсон загварын тухай мэдээллийг харж болно 

(Зураг 11) Ok товчлуурыг дарна.   

 

Зураг 11   Бүдүүвч диаграм байгуулах 



Бүдүүвчийг сонгож оруулснаар бүдүүвчид мэдээлэл оруулах, элемент нэмэх, хасах, 

элементийн түвшинг өөрчлөх, өнгө хэлбэрийг өөрчлөх, хэмжээг өөрчлөх, эффект оруулах 

зэрэг боломжтой болох ба түүнтэй ажиллах нэмэлт цэсийг ашиглана. 

 Холбоос оруулах : Үндсэн баримттай танилцах явцдаа тухай хэсэгтэй холбоотой 

мэдээллийн эх сурвалжтай холбох холбоосыг үүсгэж, ашиглах нь тохиромжтой.  Эхлээд 

холбоосыг төлөөлөх текст буюу объектыг идэвхжүүлнэ (Зураг 12) 

1. Insert->Link->Hyperlink командыг сонгоно.   

2. Нээгдэх Insert Hyperlink харилцах цонхны Link to талбарын Place in this document 

талбарыг сонгож, холбох файлыг зааж өгнө.  Энд e-mail хаяг, вэб хуудас эсвэл шинэ 

файл үүсгэж хадгалах боломжтой.  

3. Insert hyperlink харилцах цонхны  Ok товчлуур дээр дарна. 

 

 

 

 

 

 

 

 

Зураг  12 Hyperlink буюу холбоос хийх командын цонх 

                               Баримт хэвлэх, тохиргоонууд хийх 

Баримтыг хэвлэхийн тулд сүлжээнд холбогдсон хэвлэх төхөөрөмжийн програм 

суулгагдсан байх ёстой. Компьютер хэрэглэдэг хүмүүс ихэвчлэн мэдээлэл болон өгөгдөл 

гэсэн ойлголтуудыг ижил утгаар хэрэглэдэг байжээ. 1970-аад болон 1980-аад оны үед 

байдал өөрчлөгдсөн. Тэр үед анхны компьютерийн өгөгдлийн сан үүссэн байна. 

Компьютерийн ухаанд өгөгдөл гэдгээр ихэвчлэн шалгагдаагүй байгаа мэдээллийг 

илэрхийлдэг. Энэ нь өгөгдөл - ийг өөрчлөөгүй, засварлаагүй байгаа ба түүнд тулгуурлаж 

болохгүй гэсэн үг. Мэдээлэл нь шалгагдсан өгөгдлийг илэрхийлэх ба юу гэдэг нь 



тодорхойлогдсон байна. Мэдээллийг хэвлэхдээ стандарт хэрэгслийн мөр дэх хэвлэх 

товчлуурыг дарснаар хялбархан гүйцэтгэнэ. Гэвч энэ тохиолдолд хэдэн хуудас хэвлэх, ямар 

хуудсыг хэвлэх зэргийг заах боломжгүй. Харин цэс ашиглан хэвлэх үед дээрхи сонголтыг 

хийж болно. Принтеээс хэвлэх олон боломж байдаг. 

Хялбар тохиргоо ашиглан хэвлэх 

 Принтерийн драйверын цэсийн зүйлс 

 2-талаар хэвлэх 

 Товхимол хэвлэх 

 Нэг хуудсан дээр хэд хэдэн хуудсыг хэвлэх 

 Цаасны хэмжээнд тааруулж хэвлэх 

 Ямар ч томруулалтад жижигрүүлсэн эсвэл томруулсан баримт бичгийг хэвлэх 

 Томруулахын тулд олон хуудсан дээр нэг зураг хэвлэх (Зурагт хуудас хийх) 

 Давхарлах эгнүүлэх тэмдэг ашиглаж зурагт хуудас хийх 

 Хялбар хэвлэлтийн хэвлэх урьдчилсан тохиргоо нэмэх 

 Олон файлыг хамт хэвлэх 

 Принтерийн өнгийг тохируулах гэх мэт  

Мэдээллийг бүхэлд нь хэвлэх : Баримтыг бүхэлд нь эсвэл баримтнаас хэсэгчлэн хэвлэх 

боломжтой. File цэсээс Print команд өгөхөд хэвлэх цонх гарна. Энэ цонхны хэвлэх 

хуудасны хязгаар (Page Range) хэсэгт бүх хуудас (All) гэсэн сонголт хийгдсэн байна. (Зураг 

13)  

Шинээр баримт үүсгээд мэдээлэл оруулсны дараа файл болгон хадгалах 

хэрэгтэй. Үүний тулд: 

1. хэрэгсэл дээр дарна. Эсвэл File цэсний Save командыг сонгоно. 

2. Save as... гэсэн цонх жижиг нээгдэнэ. 

3. Save in хэсэгт хаана файлаа хадгалах замыг зааж өгнө. 

4. File name хэсэгт файлдаа нэр бичиж өгнө. 

5. Save as type… хэсэгт файлынхаа хадгалах төрлийг сонгоно. 



 

 

 

 

 

 

 

 

 

 

Зураг 13   Баримтыг хэвлэх команд 

1. File->Print командыг сонгоно.  

2. Printer талбарт хэвлэх төхөөрөмжийн нэр байх ба өөр хэвлэх  төхөөрөмжийг сонгох 

боломжтой.  

3. Printer Properties хэсэгт дарж принтертэй холбоотой тохиргоонуудыг хийнэ.  

4. Цаасны нэг талд хэвлэх бол Print one Sided, хоёр талд хэвлэх бол Print on both sides, 2 

талд хэвлэх зүйлийн толгой 1 тийшээ харах бол Flip pages on long edge, зөрөх бол Flip 

pages on short edge талбарыг сонгоно.  

5. Хэвлэх зүйлийн нэг хувийг хэвлэсний дараа дараах хувийг хэвлэх тохиолдолд Collated, 

нэг хуудсыг хувилах тоогоор хэвлэсний дараа дараагийн хуудсыг хэвлэх тохиолдолд 

Uncollated сонголтыг хийнэ.  

6. Хуудсыг босоогоор нь бол Portrait orientaition, хөндлөнгөөр нь хэвлэх бол Landscape 

Orientation сонголтыг хийнэ.  

7. Цаасны хэмжээг өөрчлөх, захын зайг өөрчлөх, нэг цаасан дээр хэдэн хуудас хэвлэх, 

хуудастай холбоотой өөрчлөлт хийхдээ Page Setup холбоос дээр дарна.  

8. Copies талбарт хэвлэх тоог оруулна.  

9. Дээрхи тохиргоог хийгээд хэвлэх бол Print, хэвлэхгүй бол Esc товчлуур эсвэл ажлын 

талбарын аль нэг хэсэг дээр дарна.  

10. Нэг хуудас хэвлэхдээ хэвлэх цонхноос курсор байрласан хуудас (Current page) сонголт 

хийж, Оk товчлуур дарж сонгосон хуудсыг хэвлэнэ. Нэг хуудас хэвлэхэд дээрх 



сонголтоос гадна хэвлэх хуудасны дугаарыг хуудас (Pages) хэсэгт өгч хэвлэж болно. Нэг 

хуудас төдийгүй хэд хэдэн хуудсыг сонгон хэвлэхэд хуудасны дугаарыг тавина. 

Тухайлбал 7-9, 11,16 гэсэн сонголт нь 7, 8, 9, 11, 16 дугаартай хуудсуудыг хэвлэнэ. Хэрэв 

дараалсан хуудаснууд хэвлэх гэж байгаа бол эхний ба сүүлийн хуудасны дугаарын 

хооронд зураас тавина. Өөр, өөр хуудас сонгож хэвлэж байгаа бол таслал тавина.   

11. Хэвлэхийн өмнө баримтыг хэвлэх хэлбэрийг харахад  File цэсээс Print Preview 

командыг сонгоно. Эсвэл хэрэгслийн мөрөөс Print Preview товчлуур дарна. Хэвлэх 

байдлыг харах дэлгэц гарна. 

12. Хулганы заагчаа засвар хийх хэсэг дээр байрлуулан зүүн товчлуурыг нэг дарахад 

мэдээлэл томорч харагдана. Magnifier товчлуурыг идэвхжүүлнэ.  

13. Баримтын аль нэг хэсэгт заагчаа байрлуулаад зүүн товчлуурыг нэг дарахад та баримт 

руугаа орох ба засварлах боломжтой болно. 

14. Засвар хийж дууссаны дараа Magnifier товчлуурыг дарна. Ингэхэд хулганы заагч 

томруулагч шилний дүрстэй болно. 

15. Нэг товшилт хийхэд мэдээлэл хуудасны хэмжээгээр харагдана.  

Принлээд гаргах бүтээгдэхүүнд жишээ нь төрөл бүрийн товхимол баж болно. Энэ нь 

ерөнхийдөө хагас текст (bifold) эсвэл гурав гурваар (trifold) эвхдэг текст, зургуудын нэг 

хуудас юм. Мэдээлэл нь ихэвчлэн тодорхой бүтээгдэхүүн, компани, үйл явдлыг 

танилцуулдаг. Товхимолыг товхимол эсвэл ухуулах хуудас гэж нэрлэж болно. 

Үгийн олон загварыг нээж, хэрэгцээгээ тохируулахын тулд Word-ийн ямар ч хувилбарт 

товхимол үүсгэж болно. Та мөн хоосон баримт бичгийг нээх, хуудасны тохируулгуудыг 

ашиглах замаар эхнээс нь товхимол үүсгэж, өөрийн багануудыг үүсгэж, загвараа зурж 

эхнээс нь гаргах боломжтой. 

Ерөнхийдөө та Enter товчлуурыг "Энэ бол текстийг дараагийн мөрөнд шилжүүлэх 

товчлуур" гэж ойлгох ч бий.  Enter товч нь зөвхөн шинэ догол мөр гаргахад хэрэгтэй. Та 

мөн догол мөр хоорондын зайг нэмэгдүүлэхийн тулд "хоосон догол мөр" хийхэд ашиглаж 

болно. "Текстийг дараагийн мөрөнд оруулах" ад хүмүүс мөр бүрийн төгсгөлд Enter товчийг 

дарж, догол мөрний дотор шинэ мөрөнд хиймэл текст үүсгэдэг. 

Enter товчийг дарахад засварлагч бүх бичигдсэн блок нь тусдаа догол мөр болно. Энэ арга 

нь текстийг дараагийн загвар мөр бүрийг Enter товчоор ороосон баримтын хуудасны 

форматыг шинэ мөр болгон өөрчлөхийг оролдоод үзэхэд тухайн баримт бичгийн текст 



хэрхэн "хумигдаж" (хэрэв та хуудасны хэмжээг багасгавал) эсвэл бөглөхгүй байхыг харах 

болно.  

Баримтын харагдах горимыг тохируулах 

Word програм нь хийж байгаа үйлдлээсээ хамааруулан баримтыг дэлгэцэнд хэрхэн 

харагдахыг тохируулдаг. Байдлын мөрний баруун хэсэгт байрлах Print Layout , Full Screen 

Reading   Web Layout , Outline , Draft    горимын товч байдгаас гадна View командын  туузны 

Document Views  бүлэгт дээрх команд байрладаг. Дэлгэцийн харагдах горимийн үүргүүдийг 

авч үзвэл: 

Хэвлэх байдлаар харах горим  (Print Layout) 

Хэвлэх байдлаар харах горим /Цаашид Print Layout горим гэнэ./-оор текст, график зэрэг 

бусад элементүүдийг хэвлэх үед цаасан дээр хэрхэн байрлахыг харах боломжтой. Мөн энэ 

горим нь хөл толгой тэмдэглэгээ оруулах, цаасны ирмэгээс текст хүртлэх зайг тогтоох, 

зургийн объектийг засварлах, баганатай ажиллах гэх мэт боломжийг олгодог. 

Уншилтийн горим (Full Screen Reading ) 

Энгийн буюу үргэлжилсэн горим нь текстийг шивэх, засварлах, форматлах боломжийг 

олгох боловч цаасны ирмэг, толгой хөл текст, дэвсгэр фон, дүрс болон зургийн объект 

зэргийг дэлгэцэнд харуулдаггүй. 

Вэб хуудасны горим (Web Layout View) 

Вэб хуудас хийх, баримтыг вэб хуудас хэлбэрээр харах зорилгоор энэ горимыг ашигладаг. 

Энэ горимоор Microsoft Explorer, Netscape гэх мэт вэб зуучийн програмын цонхонд дэвсгэр 

фон, дүрс болон зургийн объект, текст хэрхэн байрлаж байгааг харж болно. 

Бүтцийн горим (Outline Layout ) 

Бүтцийн горимоор баримтын бүтцийг харж гарчиг, дэд гарчиг, эх текстүүдийг шинэчлэх, 

үүсгэх, хуулах, зөөх, устгах зэрэг үйлдлийг хялбархан хийх боломжтой. Мөн гарчигаас дэд 

гарчиг болон эх текст рүү шилжих, баримтын бүтцийг дэлгэрүүлэн, эсвэл хураангуйлан 

харж болно. 

Баримтыг унших байдлаар харах горим (Draft) 



Баримтыг хянан засварлах /редакторлах/ үед энэ горимыг ашиглана. Энэ горимыг сонгосон 

үед цаасны тохиргоо, хөл толгой тэмдэглэгээ, дүрс болон зургийн объектыг өөрчлөх 

боломжгүй бөгөөд зөвхөн эх текстийг хянан засварлаж болдог. 

Баримтын дэлгэцэнд харагдах хувийг тохируулах 

Дэлгэцэнд баримтыг хэрэглэгч өөрийн хүссэн хувиар тохируулан харуулах хэд хэд арга 

байдаг. Үүнд: 

Байдлын мөрөнд байрлах томруулагчийг (Zoom)  хулганы заагчаар гүйлгэх, 

Гараас Ctrl дараад хулганыг эргүүлэгч дамар­­­­­­­­ыг эргүүлэх, 

View командын туузны Zoom  бүлэгт орших дараах  командуудаас  сонгох 

Page width – баримтын  өргөнөөр 

Text width -  баримтын текстийн өргөнөөр 

Whole page – бүтэн хуудсаар 

Many pages – олон хуудсаар Percents –  өгсөн хувиар 
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